
gprs features
> Tri-band GPRS/GSM card for use on networks worldwide: EGSM900, GSM1800, PCS1900

> Provides GSM and GPRS Data (up to 57,6 kbps) connectivity

> GPRS Class B, Type 1 GPRS MT

> Multislot Class 10 GSM 05.02 (4 slots receive, 2 slot transmit, 5 maximum active simultaneously)

> ETSI Multiplexer for simultaneously connections and network coverage reports

> Integral antenna: robust, retractable and flexible, user exchangeable

> GPRS SMS Supported

> Supports EAP-SIM (3GPP TS 13.234 within the purview of 802.1x Authentication)

> The embedded SIM reader is provided with a related API-interface: PC SC-driver

> Optional Accessory: external tri-band GPRS/GSM antenna

> Roaming between GPRS/GSM networks

wlan features
> WLAN card for use on 2.4 Ghz band

> WLAN high speed data (up to 11Mbps) connectivity

> 802.11b Ethernet Interface

> 802.11 WEP encryption and Wi-Fi certified WPA

system requirements
> Windows 98SE/ME/2000/XP/Server 2003

> Type II PC-Card slot
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Warning ! Do not insert the card !

Registering your card is of great value to you.

As soon as you register, you will qualify for:

> Validation of warranty, which includes repair or replacement if faulty

> After-sales customer care

> Advanced bulletins on product updates and software upgrades

During the installation process, you will have the possibility to register online 

or via e-mail.

You also have the alternative to register on-line directly at:

http://www.option.com/registration/4_3_registration.shtml
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Congratulations on your purchase of the Option GlobeTrotter card.

GlobeTrotter is the ultimate solution to provide high performance mobile wireless

functionality for Laptops and Notebooks enabling users to browse the Internet,

send and receive e-mail, with SIM management seamlessly integrated with

Microsoft Outlook™.

The “Always On” feature of GPRS lends itself to real time remote connectivity and 

is ideal for the synchronization of mobile devices with the office or home computer.

GlobeTrotter is designed to support IPsec client software providing secure remote IP

mobile access to corporate networks.

The GlobeTrotter card plugs into any compatible portable computers or other

devices with a PC Card type II or III slot.

This guide describes how to install the GlobeTrotter Mobility Manager (GTMM) 

software on your PC and how to start using it. For more detailed information,

consult the GTMM Online Help Guide.

Contents of the sales package

In the sales package, you will find the following items:

> Option GlobeTrotter card

> A CD-Rom containing the software

To overcome any installation and usage barriers and to enhance the user experience,

the following documentation is also included:

> Quick Start Guide, which gives the installation of the GlobeTrotter Mobility

Manager Software in a limited number of steps, and assists the user in making

his/her first data call

> Online User Manual, which describes a number of common scenarios of use. The online

User manual can be accessed at all times through the Help menu of the software.

introduction4

The GlobeTrotter card requires:

Processor

> Client (a computer not working in a server capacity): Min. 90-megahertz (MHz)

Intel Pentium II-class processor or higher 

> Server (a computer working in a server capacity): Min.133-MHz Intel Pentium-

class processor 

Operating System
> Microsoft Windows® Server 2003

> Windows XP Professional

> Windows XP Home Edition 

> Windows 2000 

> Windows ME 

> Windows 98SE

Memory
> Client: 64 megabytes (MB) of RAM, 96 MB recommended 

> Server: 128 MB of RAM, 256 MB recommended  

Hard Disk
Min. 40 MB for installation of SW & Drivers

Display

800 x 600 or higher-resolution display with 256 colors

Input Device

Microsoft mouse or compatible pointing device

Slot

Type II PC-Card slot

system requirements (minimum requirements) 5



The GlobeTrotter Mobility Manager

The GlobeTrotter Mobility Manager simplifies SMS messaging and the configuration

of GPRS settings for applications such as downloading e-mail or browsing the Internet.

It also gives the possibility to make a WLAN connection.

The GTMM application also incorporates a powerful SMS editor, message templates,

and a viewer for reading SMS messages. Incoming and outgoing messages are listed

in Outlook™-style directories.

The Setup page gives users a quick and easy way to set up any type of connection

(GSM, GPRS or 3G).

The Option Wireless Network Client gives users a quick and easy way to scan and

connect on a WLAN network.

Installation

This section provides step-by-step instructions on how to install the Option

GlobeTrotter card on your PC.

NOTE: There are some slight differences in the installation process between

Windows 2000 and XP Pro/Home Edition. If the installation differs from the steps

described in this section, follow the instructions on the screen.

If you want to quit the Setup program without installing or uninstalling, click

Cancel and then Exit Setup to quit Setup. If you want to return the Setup program

after having quit the installation before it was completed, follow the installation

steps as if you were installing the program for the first time.

installation 7

Other requirements

> Microsoft Internet Explorer 6.00 or later 

> The latest Windows service packs and critical updates from the Windows Update site.

Network services

The GlobeTrotter card operates on the EGSM 900, GSM 1800 and PCS 1900 

cellular networks.

To use your Option GlobeTrotter card, you must first activate an account with 

a GPRS/GSM network provider and have received a Subscriber Identity Module 

(SIM) card from the GPRS/GSM provider.

Some service providers may not provide all communications services.

Contact your service provider for further information about the availability 

and details of the services in your home network.

Additional information may be required from your service provider to activate 

the GPRS functionality of the Option GlobeTrotter card such as:

> User Name - if applicable

> Password - if applicable

> Access Point Name (APN)

> IP Address - if not dynamic

> DNS Address - if not dynamic

Communications software

When you run the installation program, the following programs will be installed on

your computer:

> Windows based telephony driver (TAPI compatible)

> The GlobeTrotter Mobility Manager (TAPI compatible)

system requirements (minimum requirements)6



6. Click OK to execute the file.

7. Select the language you want to install the program in.

8. The installation will start.

9. The software will automatically be copied into Program Files\OPTION\Mobility

Manager. Another target folder can also be chosen during the installation process.

10. At the end of the installation you will have to reboot the PC and if you have selected

automatically start up, the GTMM application will start up after the reboot.

11. Insert the Option GlobeTrotter card into the PCMCIA slot of your PC.

12. Wait until the system has recognized the card.

13. You will now be asked to register the product.

Registration is required to benefit from the warranty and customer care.

By connecting to the Internet you can register online immediately 

at http://www.option.com/registration/4_3_registration.shtml

Choose Cancel if you want to register later. You will be able to start the registration

from the help menu in the main interface. When you click cancel each time you

start GTMM you will be asked to register.

Uninstalling the Option GlobeTrotter card and the GlobeTrotter Mobility Manager

1. Go to the Control Panel of the operating system.

2. Open Add/Remove Programs.

3. To uninstall the GlobeTrotter card and the GTMM software, select GlobeTrotter
Mobility Manager and click the Remove... button. Follow the steps of the unin-

stall wizard.
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Inserting the SIM card in the Option GlobeTrotter card

1. Verify that you have a plug-in SIM card and locate the golden connector 

area on this SIM. Please make sure the golden connector is perfectly clean.

2. Look for the SIM connector on top of the Option

GlobeTrotter card.

3. Slide the SIM card with the cut corner of the SIM to

the centre of the GlobeTrotter, and with the golden

connector area on it facing to the Option

GlobeTrotter card.

Antenna
You need to eject the pop out antenna from the card in order to be able to establish

a connection

Installing the Option GlobeTrotter card and the GlobeTrotter Mobility Manager

WARNING! DO NOT INSERT THE CARD!
It is advised to connect your PC to the mains, before starting the installation

1. Start Windows.

2. Close all applications.

3. Insert the CD-Rom into your computer’s CD-Rom drive. If auto play is enabled

the setup will start automatically.

4. If this does not happen, select the Run command from the Start menu.

5. Select the drive that contains the CD. Go to D:\MobilityManagerSetup*.exe
(D: represents the CD-Rom drive).

installation8



The GlobeTrotter Mobility Manager Home Page

The Home Page is the place where you have a complete overview on everything

that the GlobeTrotter Mobility Manager can offer.

From the Home Page you can:

> Access every section of GlobeTrotter Mobility Manager (the Toolbar)

> Access every subsection (the Navigation bar)

> Overview about the status of the available network

> Indication of unread SMS

> Quick connection launch

In case you have unread SMS, these will be shown in the GTMM Home Page. A text

will inform about the number of unread messages.

In the Home Page, you have the possibility to connect directly to an available network.

Once you have created or imported a connection, this will be available for a quick 

connect in the Home Page if the used network (GSM/GPRS/UMTS) is available.

getting started 11

Starting the Option GlobeTrotter card.

Slide the SIM card into the SIM card slot of the Option GlobeTrotter card and insert

the Option GlobeTrotter card into the PC Card slot of your computer. It is recom-

mended to insert the card in the top PCMCIA slot. You may have to enter the PIN

(Personal Identity Number) code if the PIN code request is activated in the SIM card.

The PIN code is usually supplied with the SIM card. If you enter an incorrect PIN

code three times in a row, you will need a PUK (Personal Unblocking Key) code 

to unblock the SIM card. If this doesn’t work, contact your service provider.

Using the GlobeTrotter card for SMS and Phonebook management

During the installation of the GlobeTrotter Mobility Manager software a link is created

in the Startup folder. GlobeTrotter Mobility Manager will subsequently start every time

the computer is turned on. The GlobeTrotter Mobility Manager icon then appears in

the task bar. If the GlobeTrotter Mobility Manager software does not start automatically

when the computer is switched on, or if the GlobeTrotter Mobility Manager program

has been closed in the meantime, it can be started again in the Start menu.

Once the program has started, the PIN code will be

requested (if the PIN code request is activated on the SIM

card) in order to activate the Globetrotter card. The card

will subsequently be registered onto the network.

If the PIN code request has been disabled,

the GlobeTrotter card will be registered on the network 

as soon as it is powered on.

At the end of the network registration the interface 

will open and the connection will start

getting started10



The Phone book

The available phonebooks are:

> SIM Phonebook

> Outlook contacts (if Outlook is present)

Contacts are read on the fly, which means no duplicate phonebooks or synchronization.

The software will operate directly on the SIM and in the Outlook contacts.

You can edit the name or phone entry in the SIM contacts by right click on the SIM

contacts and select new or by going to ‘File/New/SIM contact. Then you get the fol-

lowing popup window where you can edit your contact.

You can edit the name or phone entry in the Outlook contacts by going 

to ‘File/New/Outlook contact’. Then you get the standard Outlook window 

to make a new contact.

You can also create new, cut, copy paste either the SIM contacts or the Outlook 

contacts by clicking on the icons in the “SMS Message Management Bar”

getting started 13

The SMS Centre

You can access the SMS center:

> From GlobeTrotter Mobility Manager Home Page:

- By left-clicking once on the SMS button on the top toolbar

- By left-clicking once on the “Icon” next to 

the “You have received n SMS messages” section

- By left-clicking once on the SMS icon on the upper left navigation bar

> By left-clicking once the “SMS envelope” icon in the systray. This is as a result

of the system having recognized that a new SMS message had arrived.

The SIM or Outlook address book will be shown when clicking on the respective icon.

You can read, create, reply, forward and delete an SMS by clicking the icons on the

SMS Message Management Bar, which is located at the bottom of the GlobeTrotter

Mobility Manager SMS Page.

getting started12



You have to select which type of connection you want to set up.

You have to select either importing an existing connection or setting up 

a connection manually.

When you set up your connection manually right click on the connection and select

rename. Enter a name for your connection (e.g. My GPRS connection with Operator X)

and fill in all the parameters of your GPRS connection. Enter the GPRS settings you

received from your provider.

setup 15

The Setup page allows you to create, edit and configure a GPRS, GSM or UMTS 

connection. Also, when a connection is present, this can be started from there.

In the top of the screen you have a list of all available connections.

Using the GlobeTrotter card for a DATA connection

Caution! Some Service Providers use automatic DNS Server assignment. However 

if you can connect but have trouble opening a webpage we advise you to enter 

the DNS settings manually. Please contact your Service Provider to obtain the

required DNS settings.

Depending on your network operator, a GPRS, GSM or UMTS connection might

already have been installed. If not, you will have to create a new connection following

the next steps. Click on Setup. Click on New to create a new connection.

setup14



In Dial up Network you can modify the card

settings and the dial properties.

In Internet you can modify the internet

properties.

setup 17

In Name Servers (DNS) you can specify the DNS if required by your carrier.

In PDP type you can specify the PDP type. You can choose between IP and PPP.

If required by your carrier you have to fill in the address.

setup16



The Connection states tab

Once that you are connected,

the network status tab will

show the connection statistics.

Which means:

> Connected with (GSM/GPRS/UMTS)

> Duration of the connection

> Total volume transferred

> Sent and received volume.

> Actual speed (upload and download)

> Top speed (upload and download)

Start a connection

A connection can be started from:

> The connect button in one of the connectivity tabs

> From the controller > right-click > “Connect using” for every available connection

> From the controller > left-click > “Connect” for the default connection

setup 19

In Quality of Service (QoS), you can change the QoS parameters. See the help files for

definitions of the QoS parameters.

CAUTION ! Do not change the QoS parameters unless your provider explicitly informs
you to do so.

Click Save. You are now ready to start a GPRS connection!

Setting up a GSM connection is similar to setting up a GPRS connection, so please

refer to the above steps.

All connections can be started from the GTMM controller icon in the taskbar.

setup18



Compact Mode

The Compact Mode provides the following information:

> Profiles: Here you can select one of the available preconfigured profiles or you

can create a new connection by choosing “Create new…”.

> View Mode: OWNC has two View Modes that can be selected from this field.

> Status Overview: This list contains information about the selected profile.

Advanced Mode

In Advanced Mode you find the available tabs for the configuration of your wireless

network client. Below you find a description of each tab.

Site Survey Tab

With this tab you can perform a Site Survey. You can see the available wireless net-

work(s) in range of your WLAN device and connect to one of them. If you double-click

on one of the available networks and the Basic Service Set Identifier (BSSID) was

already configured in a profile, the corresponding profile will be applied automatically.

If the BSSID was not yet con-

figured in a profile the “Add New

Profile” wizard is started.

> Rescan: Clicking this button,

it will initiate a Site Survey

and display the BSSID of

available networks.

Note: Switching from the

Site Survey tab to another

and back again will clear 

the list of available networks.
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First time using WLAN

Click on WLAN in the Navigation bar. The Option Wireless Network Client (OWNC)

will pop up as a separate window. Standard it opens in Advanced Mode. The OWNC

is divided in two sections. The left side includes the status overview panel, signal

strength and link quality. The right side is used to configure network profiles to set

up WLAN connections.

The OWNC has two View Modes: the Advanced and the Compact Mode.

wlan (only available with globetrotter combo card)20



Connection Page

The next page is the Connection page. Here you can change the SSID of the AP you

wish to connect to. You can choose to configure whether the wireless adapter will

connect to an AP (infrastructure mode) or to another wireless adapter (Ad-Hoc or

Peer-2-Peer mode). You can also choose to enable the radio channel, the International

Roaming or the Power Saving.

The OWNC automatically selects the correct fields depending on the information

the card is receiving from the AP.

Security Page

Following on the connection page you have the Security page from which all the

security features can be configured.

Here you can select the Authentication Mode used by the AP. You also have to indicate

the encryption type if any and the keys that are used with the chosen encryption type.

This page also contains the configuration settings in case Server Authentication is required.

wlan (only available with globetrotter combo card) 23

Profiles Tab

With this tab you can create, edit or delete a profile. This is possible with the tree

buttons at the right side of the list with the available profiles.

>  Add: OWNC is using 

a wizard for creating/editing

a new profile.

Clicking the “Add” button it

will initiate the wizard and

the first page will appear.

Common Page

The first thing you have to fill in is the Profile

name. By default the OWNC is filling in the

BSSID name of the AP that has been select-

ed. Of course you can still change the profile

name by typing in another name.

You also have to select whether this pro-

file needs to be launched automatically or

not. If not it will just be added to the list

with the available profiles who can be

activated manually.

wlan (only available with globetrotter combo card)22



Statistics Tab

In this tab the statistics information is shown for the selected device. The available

information as you can see is:

> Successful Data Rx/Tx Frames

> Successful Management Rx/Tx Frames

> Rejected Rx/Tx Frames

> Matching Beacons

Includes WPA related information:

> MIC Errors

> Double MIC Errors

> Replay Errors

> APs Black List

wlan (only available with globetrotter combo card) 25

The OWNC will automatically make the

selections according to the information

broadcasted by the AP. This does not

mean the OWNC will automatically fill

out the WEP keys or the pass phrase need-

ed to configure the WPA security. These

will have to be entered manually. Please

contact your IT-administrator or network

operator for additional information.

Advanced Page

Here the final profile adjustments are made.

The Fragmentation threshold or the RTS/CTS threshold can be configured. Also, the

output power of the wireless device, the Preamble type or the Tx rate can be setup.

> Edit: This button will show you the 

“Add New Profile” wizard for editing 

the selected profile. The only thing you

cannot edit is the profile name.

> Delete: Clicking on this button you will

be asked to delete the selected profile

from the list with the available profiles.

If you have not selected any profile then

you shall be asked to select one first.

Note: The default profile cannot be 

edited or deleted.

wlan (only available with globetrotter combo card)24



Information Tab

In the Information tab, some version information is displayed.

The available information that you can find on this page is:

> Driver/Firmware version

> WLan DLL version

> Regulatory domain that the card is configured

> MAC address

> IP address

wlan (only available with globetrotter combo card) 27

Customize Tab
OWNC has the ability to adjust the amount of information displayed. This can be

configured in this tab.

> Start minimized in taskbar: If this option is selected the OWNC will start mini-

mized in taskbar.

> Auto Switch Profiles: OWNC can automatically switch to an available profile in

case 10 secs have passed and the current profile is not yet successfully connected.

wlan (only available with globetrotter combo card)26



The configuration tabs are accessible from:

> GTMM controller > Left Click > Settings > Configuration

> Menu bar > Tools > Configuration

Security

The following passwords can be changed:

> SIM PIN

> SIM PIN2

Change a password: the old password needs to be entered and two times 

the new password.

PIN code Require: if checked, PIN must be entered any time a new connection to 

the network is initiated after the device has been turned off.

configuration settings 29

Using the My Options button you can add shortcuts to your favorite applications.

With a drop down it has immediately an overview to all applications that you have

added. You can consider My Options button as an extension of the main toolbar.

From the menu View > Customize Toolbar it’s possible to choose which buttons you

want to appear in the Toolbar and in the My Options list. Or you can also do it in

‘My Options / Customize Toolbar…’

my options28



Band selection

The cards can use all three common frequencies for GSM/GPRS: 900MHz, 1800 MHz

and 1900 MHz. Automatic selection is supported for only two bands 900/1800 and

900/1900. Switching between bands has to be done manually.

When you are using a higher firmware than FW6.6.0 the band selection will auto-

matically be done. This page will not be accessible when using such a firmware.

Two radio buttons are available:

> 900/1800 MHz (Europe, Asia)

> 900/1900 MHz (Europe, US)

configuration settings 31

Network operator selection

The network operator selection window calls a list of available network operators

and selects the chosen network provider from the list.

To check the current settings and read the current list of operators from the network,

tap Query. The list displays all available operators. The operator’s status is shown in

the second column.

To register with a different operator, highlight the Operator name, tap Select and

click OK.

Selecting an operator switches the device to manual registration mode;

the device will try to register with the selected operator only. To go back to automatic

registration, you must tap Automatic.
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This section points out the basic problems that could occur when you are installing

and using the card. There is a list of symptoms and possible actions you can take in

any of the following situations below.

Not enough disk space for installation.
There is not enough space to complete the installation on the selected drive.

Select another drive for installation or delete unnecessary files to free up additional

disk space. If there are several hard disk drives in the system and you decide to

install the program on a drive other than the one where the Windows system files

are located, disk space is required on both drives. The program will always need to

place some files in the Windows directory.

Setup does not accept the target directory.

The program can only be installed on a local drive. If the path to the directory 

is over 80 characters, it will not be accepted. Select another directory or shorten 

the names of the subdirectories.

The GlobeTrotter card cannot be installed or used.

The Interrupt Request (IRQ) resources may be in conflict. Check the GlobeTrotter

resources from Control Panel/System/Hardware/Device Manager.

If there is a resource conflict, consult the Windows online help on changing 

the resource settings.

The GlobeTrotter card is not properly inserted.

Make sure that the PC Card slot or the computer is functioning properly and that the

GlobeTrotter drivers are installed(In Control Panel > Ports).

Also make sure that the SIM card has been inserted.

Refitting the antenna
When the antenna becomes disconnected, refit it as follows:
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Diagnostic Utilities

A general diagnostic tool will check the basic settings like installation, network

availability, signal strength…

Connection History, another advanced diagnostic utilities will be accessible in GTMM.
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Declaration of Conformity for products marked with the FCC logo - United States only

This device complies with Part 15 of the FCC rules. Operation is subject to the following

two conditions:

(1) this device may not cause harmful interference, and 

(2) this device must accept any interference received, including interference that

may cause undesired operation.

For questions regarding your product or FCC declaration, contact:

Option | Kolonel Begaultlaan 45 | 3012 Leuven | Belgium | www.option.com

Exposure Information to Radio Frequency Energy

This PCMCIA card has been tested in different notebooks for compliance with 

the SAR requirements.

The maximum measured body SAR values (averaged over a mass of 1 g) are 0.18 W/kg

for GSM1900 and 0.20 W/kg for WLAN, which is well below the limit of 1.6 W/kg.

For safe and efficient use the user should keep the antenna of the card at a minimum

distance of 1 cm away from this body.

CAUTION: Users concerned with the risk of Radio Frequency exposure may wish 

to limit the duration of their calls and to position the antenna as far away from 

the body as is practical.
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Federal communications commission notice

This equipment has been tested and found to comply with the limits for a Class B

digital device, pursuant to Part 15 of the FCC Rules. These limits are designed to

provide reasonable protection against harmful interference in a residential installation.

This equipment generates, uses, and can radiate radio frequency energy and, if not

installed and used in accordance with the instructions, may cause harmful interference

to radio communications. However, there is no guarantee that interference will not

occur in a particular installation. If this equipment does cause harmful interference

to radio or television reception, which can be determined by turning the equipment

off and on, the user is encouraged to try to correct the interference by one or more

of the following measures:

> Reorient or relocate the receiving antenna.

> Increase the separation between the equipment and receiver.

> Connect the equipment into an outlet on a circuit different from that to which

the receiver is connected.

> Consult the dealer or an experienced radio or television technician for help.

Modifications
The FCC requires the user to be notified that any changes or modifications made to

this device that are not expressly approved by Option may void the user’s authority

to operate the equipment.

Cables
Connections to this device must be made with shielded cables with metallic RFI/EMI

connector hoods in order to maintain compliance with FCC Rules and Regulations.
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Read these simple guidelines. Breaking the rules may be dangerous or illegal.

Further detailed information is given in this manual.

Driving: do not use the GlobeTrotter while driving; park the vehicle first.

Interference: all wireless devices may get interference, which could affect performance.

Do not use in hospitals: follow any regulations or rules. Do not use near medical

equipment.

Do not use in airplane: wireless devices can cause interference. Using them on 

airplanes is illegal.

Do not use near refueling points: do not use the device at a refueling point.

Do not use near fuel or chemicals.

Use sensibly: do not touch the antenna unnecessarily.

Use qualified service: do not attempt to dissemble GlobeTrotter. Doing so will void

warranty. Service should only be performed by Authorized Service Centers.

Accessories: use only approved accessories. Do not connect incompatible products.

Liquids: do not expose your card to rain, or spill beverages on it.

Extreme temperatures: do not expose the card or the antenna to extreme tempera-

tures, below -25 or over +70 degrees Celsius.

Traveling: handle the card with care while traveling. It is recommended to remove

the card from the laptop.

www.option.com
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European Union notice

Products bearing the CE marking comply with the R&TTE Directive (99/5/EC), EMC

Directive (89/336/EEC) and the Low Voltage Directive (73/23/EEC) issued by the

Commission of the European Community.

Compliance with these directives implies conformity to the following European

Norms (in parentheses are the equivalent international standards and regulations):

Radio Frequency spectrum efficiency:
> EN 301 511, v9.0.2

> EN 300 328-2, v1.4.1

Electromagnetic Compatibility
> EN 301 489-1: v1.4.1

> EN 301 489-7: v1.2.1

> EN 301 489-17: v1.2.1

Safety and Health
> EN 60950: 2000

> EN 50371 (07/02) & IEEE P1528/D1.2 (04/03)

This product may be used in all EU and EFTA countries.
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gprs features
> Tri-band GPRS/GSM card for use on networks worldwide: EGSM900, GSM1800, PCS1900

> Provides GSM and GPRS Data (up to 57,6 kbps) connectivity

> GPRS Class B, Type 1 GPRS MT

> Multislot Class 10 GSM 05.02 (4 slots receive, 2 slot transmit, 5 maximum active simultaneously)

> ETSI Multiplexer for simultaneously connections and network coverage reports

> Integral antenna: robust, retractable and flexible, user exchangeable

> GPRS SMS Supported

> Supports EAP-SIM (3GPP TS 13.234 within the purview of 802.1x Authentication)

> The embedded SIM reader is provided with a related API-interface: PC SC-driver

> Optional Accessory: external tri-band GPRS/GSM antenna

> Roaming between GPRS/GSM networks

wlan features
> WLAN card for use on 2.4 Ghz band

> WLAN high speed data (up to 11Mbps) connectivity

> 802.11b Ethernet Interface

> 802.11 WEP encryption and Wi-Fi certified WPA

system requirements
> Windows 98SE/ME/2000/XP/Server 2003

> Type II PC-Card slot
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